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FOCUS OF THIS GUIDE
Our focus with this Guide is to show you how to use Things® 3 on your Mac desktop for your GTD® workflow.
The Guide is packed with our best practices for configuring and populating Things for your Projects, Next
Actions, Waiting For, Someday/Maybe, and Reference lists. We’ll also cover strategies for managing your
calendar and email.
If you are new to Things, this Guide is an excellent starting point for you to build a solid GTD foundation
for optimizing your productivity. If you already have an established system in Things, use this Guide as an
opportunity to fine-tune or simplify, if you have found you’ve underused or overbuilt your setup.
This is not a technical Guide, nor will it cover all the instructions for how to use Things. We’ll leave that to the
folks at Things to share with you through their excellent support material.
There are many ways you could configure Things for GTD. This Guide focuses on the methods we have found
work well for GTD for a wide range of people. It’s also important to note that no one tool will handle all of your
needs for GTD, including Things. Even with your lists managed in Things, you’ll still have your calendar and
email in other programs.
Whatever configuration you choose in tools like Things, be careful not to overcomplicate it to the point where
you can only maintain it when you are at your peak of mental clarity. It’s too easy to have a complicated system
fall apart when you’re not at your best. Your GTD tools should be complex enough to manage your workflow,
but simple enough that if you were sick in bed with the flu, you could still easily maintain them.
Don’t worry about using every available feature in Things (or any of your tools for that matter). There may be more
offered than you will ever need. Focus on what makes a difference for you.
OK…let’s get started!

Be careful not to overcomplicate your
systems to the point where you can
only maintain them when you are
at your peak of mental clarity.
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UNDERSTANDING THE GTD BEST PRACTICES
To get the most out of Things as a tool for your GTD practice, let’s review the fundamentals of the Getting Things
Done® approach, so you understand how the methodology and tools will intersect.

WHAT IS GTD?
GTD is the shorthand brand for “Getting Things Done”, the groundbreaking work-life management system and
bestselling book1 by David Allen, which provides concrete solutions for transforming overwhelm and uncertainty
into an integrated system of stress-free productivity.

GTD’S FIVE STEPS OF MASTERING WORKFLOW
CAPTURE
CLARIFY
ORGANIZE
		

REFLECT
ENGAGE

Collect anything and everything that’s grabbing your attention.
Define actionable things into concrete next steps and successful outcomes.
Sort information in the most streamlined way, in appropriate categories,
based on how and when you need to access it.
Step back to review and update your system regularly.
Make trusted choices about what to do in any given moment.

THREE STAGES TO INTEGRATING GTD
1. UNDERSTANDING

You understand the distinct differences in the five steps of Mastering Workflow. You understand
a project versus a next action. You know how to transform what you’ve collected by asking the key processing
questions, clarifying what something is, and what you want to do about it.

2. IMPLEMENTATION

You have installed at least the basic gear to support your GTD practice, including ubiquitous
collection tools, functioning reference systems for your non-actionable information, and seamless buckets with
“clean edges” for tracking your projects and next actions.

3. BEHAVIOR CHANGE

The five steps of Mastering Workflow are second nature to you. You have changed the way
you think and work and are achieving stress-free productivity on a regular basis. When you “fall off” you know
what to do to get “back on.”
This Guide will leap forward to the Implementation stage, by configuring Things as an organizing tool for your
projects, actions, and reference. Success at the implementation stage depends on your understanding of GTD.
If you are committed to GTD and experiencing stress-free productivity, don’t shortchange yourself by skipping the
“Understanding” stage.

1

Getting Things Done: The Art of Stress-Free Productivity; Viking, New York; 2001, 2015 hardback or paperback.
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THERE ARE MANY WAYS TO GET A BASIC UNDERSTANDING OF GTD, INCLUDING:
Read or listen to the book Getting Things Done is the essential manual for this methodology (part one is an
excellent overview of the whole game).
Take a course The courses offered by our global partners around the world are excellent primers for understanding
the key steps of Mastering Workflow.
Practice, practice, practice The GTD Workflow Map (shown below) is a fantastic coaching tool for walking
yourself through the core models for capturing, clarifying, organizing, reflecting, and engaging.

THE GTD WORKFLOW MAP

Purpose
Vision
Goals
Areas of Focus
and Accountability

WHAT IS IT?

IS IT ACTIONABLE?

WHAT’S THE
DESIRED OUTCOME?

(If multi-step)
PROJECTS

TRASH

Recycle, shred, delete
Project Support Material
(review for actions)

WHAT’S THE
NEXT ACTION?

DEFER IT

For me to do, specific to a
day or time (calendar / tickler)
For me to do, as soon as I can
(Next Actions lists / folders / trays)

INCUBATE

REFERENCE

DELEGATE
DO IT

Possible
later
action

Someday / Maybe lists / folders

Date-specific triggers

If less than 2 minutes
Paper / digital – lists / folders

In communication system and being
tracked on Waiting For list / folder

We recommend getting the full Workflow Map, with all of the GTD models, which comes as a PDF download.
Visit our online store at gettingthingsdone.com/store to learn more.
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APPLYING GTD TO THINGS

®

SETTING UP THINGS FOR GTD
USING THINGS TO MANAGE YOUR KEY LISTS
Things is an excellent option for managing the Projects, Next Actions, Waiting For, and Someday/Maybe lists
in your system. We appreciate the simplicity and flexibility of this tool for implementing GTD. We suggest you
create lists in Things to match the common set of lists recommended in the Getting Things Done book, which
we describe in more detail over the following pages.

THE MOST COMMON GTD LISTS
HERE ARE THE 10 LISTS THAT ARE A GOOD STARTER SET FOR MOST PEOPLE:
1.
2.
3.
4.
5.

Agendas
Anywhere
Calls
Computer
Errands

6. Home
7. Office
8. Waiting For
9. Someday/Maybe
10. Projects

Sorting your next actions by context (lists 1–7 above) is recommended because when you are choosing what
to do, context will always be your first limitation. For example, if you are the office, you don’t want to be seeing
(and having to take the time to skip over) actions that require you to be at home to do. Contexts should map
to the people, places, and tools you need to get work done.
Let’s set up the 10 suggested lists in Things now. You can always go back to customize these later, after you’ve
experimented, to discover what works best for you. We encourage you to give these lists some time, especially
if the concept of sorting by contexts is new to you.
We recommend doing this initial setup on your desktop and not your mobile device.
While there are a number of ways one could set up Things, there is one method, in particular, we have found
to work well for many users of Things, which is:
yy Setup all lists using “Projects” type of entry.
yy For additional sorting into topic folders, create “Areas”.
yy Use Tags, if needed and sparingly, for areas of focus, linking key projects to their related actions,
or specific topics.
Things is so elegantly functional for GTD, if you simply started by setting up all of your lists as Project entries
(and didn’t dive into using Areas or Tags,) you would have a very functional system by our standards!
First, let’s use “Project” entries in Things to manage all of your lists. You’ll need to get creative in your thinking
and essentially ignore that this is called “Projects.” Think of it as simply your “lists” area.
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We’ll explain what goes on these lists later in the guide, but for now, create 10 lists that match the starter set
recommended in the Getting Things Done book:
Agendas
Anywhere
Calls
Computer
Errands

Home
Office
Waiting For
Projects
Someday/Maybe

To add a new list, click the + New List button in the bottom left corner and select New Project, or choose
File > New Project, or use the keyboard shortcut Option + Command + N.

We recommend moving Projects to the top of your list view and Someday/Maybe to the bottom. Visually, this
gives a good view of Projects being a higher horizon above Next Actions lists (Calls through Waiting For). To move
a list, click on the name of a list and drag and drop the list to a new location.

ADDING ITEMS TO YOUR LISTS
You will add projects and actions as “To-Do” entries under the 10 lists you just created. There are a number
of ways to add new items to your lists.
Go to the list where you want to add a new item and use any of these options:
yy Click the

icon at the bottom of the list

yy Press the Spacebar
yy Use the keyboard shortcut Command + N
yy Go to File > New To-Do
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From anywhere in Things:
yy Use the Quick Entry window by pressing Control + Spacebar. Type your entry, then choose a list to assign
it to by clicking on the list selection menu or by using the tab key on your keyboard to cycle through to the
list selection menu. Type the first few letters of the list name and use your arrow keys or mouse to select
the list. Press enter/return to save the new entry.
From other applications, such as Mail or Safari:
yy Add items with Quick Entry using the keyboard shortcut Control + Alt + Spacebar. The Quick Entry window
will contain a link to the email message or webpage as well as any text you’ve selected. To enable this
feature, be sure to check off Quick Entry with Autofill in Things Preferences AND install Things Helper
when prompted.
Note: If you don’t select a list in Quick Entry, the item will be saved in your Things Inbox. The Inbox is a default
setting that you can change in Things Preferences. Also, if these shortcuts don’t work for you, it could be that
another program you have installed is using them. You can select different ones in Things Preferences.
We’ll talk about more options for adding items to lists later in the Guide when we cover the Things Inbox and
Integrating Your Actionable Email.
You have a number of options available when adding a new entry directly to a list:
1. Describing the project or next action
2. Creating a start date
3. Assigning a tag
4. Creating a checklist
5. Creating a due date/deadline
6. Marking an item complete/send to Logbook
7. Adding Notes about the to-do entry
8. Adding Notes about the list
(be sure not to confuse this with #7)
9. Change details about the list
Note: There is no need to assign a list using this window, because it will be automatically saved in the list
you are viewing. If you create an item in the wrong list, simply drag and drop it to the correct list.
The Quick Entry window is nearly identical to the window above, but also adds choice of what list to assign
it to (the default is Inbox).
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USING SHORTCUT KEYS
The ability to capture information and facilitate tasks quickly, through shortcut keys, can greatly enhance your
productivity. Things offers many shortcut keys for common functions in the app. Here is a short list of the
most common ones:
Create a new to-do: Spacebar, +

within each list, or Command + N

Create a new checklist in an open to-do: Command + Shift + C
Create a new project (what we call list): Command + Option + N
Create a new heading in a list: Command + Shift + N
Create a new list item using Quick Entry: Control + Spacebar
Deadline (due date) +1 day: Control + Period
Deadline (due date) +1 week: Shift + Control + >
Go to Inbox: Command + 1
Go to Today view: Command + 2
Go to Upcoming view: Command + 3
Go to Anytime view: Command + 4
There are many more useful shortcuts available as well, on the Things Support site. Again, if these shortcuts
don’t work for you, it could be that another program you have installed is using them. You can select different
ones in Things Preferences.

USING SIRI
If you’re an iPhone user on at least iOS 11, you can use Siri to add new and view existing items in Things.
For example:
To add something to your Computer list, say “Add to my Computer list in Things.” Siri will ask you what the
new to-dos should be. Say “Email Singapore office about next meeting.” If you have multiple new To-Do’s
to add, separate them with the word “and”. For example, “Email Singapore office about next meeting and
Email Kyle that I need updated budget.”
For more instructions and examples on using Siri with Things, view the helpful support doc on the Things
website. Now, we’ll go into greater detail about what goes on these lists.

EXPLANATION OF THE COMMON GTD LISTS
AGENDAS

This list tracks the topics and agenda items for people you interact with regularly. For example, if you
have a standing meeting with a particular team, and want to capture agenda items to bring up at the next
meeting, this is the place to capture them. The Agenda list is not for tracking next actions that you need to take
related to that person or team (for example, a call you need to make to that person, which would instead go on
your “Calls” list). Once you’re on the call, you may refer to the Agenda list for that person, but it’s the Calls list
that is triggering the action to make the phone call, not Agendas.

© 2018 David Allen Company. All rights reserved. 825-LTR 27JUNE2018

gettingthingsdone.com

APPLYING GTD TO THINGS

7

You could easily have half a dozen people and meetings that you are tracking through Agenda lists—your direct
reports, your boss, your assistant, your spouse, the weekly staff meeting, the monthly board meeting, etc.

THREE OPTIONS FOR CREATING AGENDAS
There are three different ways we recommend for creating Agenda lists in Things. Please read through all three
options described below, before setting up your Agenda lists, so you can best assess which option(s) will work
best for you.
1. Create agenda lists for each person/team under one Agendas List
To create an agenda for a particular person, click on the Agendas list and click the
or your Spacebar, and type the person’s name (e.g. David Allen) in the title field.

icon, or Command + N,

Or, use Quick Entry with the shortcut keys Control + Spacebar and select Agendas as the list.
To capture specific items for that Agenda list, enter those in the Notes field. The entry will remain static, as long
as you need agenda items for that person, whereas the Notes field will be dynamic, as your agenda topics for
them change.
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We’ve entered the agenda items in the example above as simple text notes. Things also offers a more linear
approach to this Notes field through checklists. To create a checklist within the Notes field, click the checklist
icon
and start typing your list.
The advantage of a checklist is that you can mark an item complete. It stays in the Notes field grayed out.
This could be useful if you ever need to retrieve older agenda topics.

There is no icon or built-in Things feature for adding files to the Notes filed. However, you can open Finder
and drag a file to the Notes field to create a shortcut back to it on your computer. To do this, open Finder,
file the file you want to link, and drag it over to the Notes field in the Things entry you want to add it to.
To move text or a checklist item in the Notes field to another list, simply highlight the item with your mouse and
drag it to the new list. For example, if you decided to email David about “Dinner in SF next month?,” highlight
the item and drag it to the Computer list. Add a verb to define your next action.
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2. Create agendas items for each person/team as separate entries under one Agendas List
Another way to add Agenda items is as individual list entries, starting with the person’s name. For example:

Some people like this option for its flexibility in quickly adding new agenda items without having to navigate
to the Agenda list and Notes field for a particular person. You can also easily drag and drop items to other lists.
The downside, though, is that your agenda items will be dispersed among a potentially very long Agendas list,
and you’ll have to manually sort entries to get them to group by person.
Another feature of Things that could be useful for your Agendas list is to create Headers to group different
types of people, teams, or areas of interest. To create a header, click on the Headers icon
at the bottom
of your Agendas list, or use the keyboard shortcut Command + Shift + N. Name your header and drag the
relevant Agenda lists under it. For example, here we have created Headers for “Work” and “Personal.”
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Or, you could create a header for a person and then list agenda items for them under the header. Like this:

3. Create a list for a person or team
Some people have so many items for just one person or team that they create an entire list for them, rather than
park them as an entry under the Agendas list. For example, if David were your boss and you often have a large
volume of agenda items to track, you might create a list dedicated to David:

If you create a list for a specific person or meeting you’ll have a little more flexibility in how easily you can add
new entries to that Agenda topic by using your shortcut keys to create a new list entry or drag and drop an entry
from another list, versus going to Agendas list > Person/Meeting > Notes field.
Just be careful you don’t create so many lists that it becomes difficult to find what you need and keep them current.
Remember, Agendas are for standing items to discuss or bring to a meeting. They are not where you would
go to be reminded of a next action you have related to that person. For example, if you needed to pull together
some SEO figures for the next marketing meeting (which is also an agenda item), this list would not be your
reminder to do that, something like your “Computer” list would be.
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ANYWHERE

An action that can be accomplished, without any restriction about where it’s done, would go on this
list. Notice in the example below that all the next actions on this list start with a verb. We recommend that as the
best practice for all of your next actions entries, so that when it comes time to choose what to do, you’ve already
done the thinking about what your action is.

CALLS

Place reminders of calls you need to make on this list if they can be made from any phone. If a call
requires a specific location instead (like home or office), we recommend putting the action in one of those
lists instead. If the phone number is not already in your contacts, then add it to the title, so you’re ready
to go when you’re available to make the call.

COMPUTER

If the action requires a computer (e.g. emails to send, documents to edit or draft, spreadsheets
to develop, websites to visit, data to review, etc.), add it to this list. This list then comes into play whenever
you are at your computer(s) with any discretionary time. Even if you only have a computer in the office,
it’s still convenient to have this list separate from your Office list of things to do, because you wouldn’t need
to look at this list when you are looking for non-computer things to do. Many people these days also like
to have a separate Computer list just for email next actions, given their volume.
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ERRANDS

This list holds reminders of things that you need to do when you are “out and about” (e.g. take
something to the tailor, buy something at a store, etc.). If you are likely to think of more than one thing to do
or get at one of those locations (like the pet store), you can make “Pet store” the Subject and put your running
list of things to get/do there in the Notes field.

If you travel quite a bit for work, you might consider having two errands lists—one for things you could
do anywhere, in any city, and one for errands that need to be completed where you live.

HOME

This list is for next actions that have to be done in your home environment (e.g. gather tax receipts,
repair the cabinet door, organize old hard copy photos, etc.).

OFFICE

These are the next actions that require you to be at your office, such as calls that you have to make
from your desk because of the materials or equipment (like your laptop) you need for the call, purging old
printed files, scanning documents on the office scanner, etc.
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WAITING FOR

This list keeps track of all the actions, projects, and deliverables that you want to happen, but which
are someone else’s responsibility. It could be something you’ve ordered that hasn’t come yet, something you’ve
handed off to your assistant for which you’re waiting on a response or something your boss is supposed to be
finding out before you can move forward on a key project.

We suggest adding the date you started waiting in the description of the item. This can be helpful when
deciding when it’s time to follow up again if they have not responded.
The Waiting For list should be reviewed as necessary (at least once a week in the Weekly Review), triggering
appropriate actions on your part to follow up, light a fire, or just check the status.

SOMEDAY/MAYBE

These are the things you might want to do at some point in the future, but with no commitment
to move on them at present. They could represent next actions or projects that were current at one time or not.
Many people find they triage things onto and off the Someday/Maybe list when their priorities shift. Your only
commitment to items you put on the Someday/Maybe list is that you will review the choice regularly in your
Weekly Reviews. That should give you the freedom to capture onto this list without the stress of feeling like
you’ve made a commitment you may not have the resources to take on.

If you have many Someday/Maybe items, you may want to split them off by topics, such as personal,
professional, travel, like to buy, potential house projects, etc.
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PROJECTS

The Projects list tracks any of your desired outcomes that require more than one action step to complete,
which you expect to be done over the next 12 months. Projects should always have a defined endpoint.

Any notes you have about the project, also known as your project plans/project support, can be added to the
Notes field for each project on the list. While this Notes field may not be robust enough to capture all of your
project details, and it may not make sense to transfer everything to this location (such as all of the emails also
related to the project), it will be useful for quick bullet lists of notes, files, milestones, and “future” actions you
want to capture. The current next actions and waiting fors for the project are not tracked in this Notes field
but on those lists.
Example of project support/plans/notes in the Notes field of a project:

Remember, the recommendation is that project support only holds future actions, project plans, notes, and support
material. Current next actions on a project are instead tracked under the correct context list.

LINKING PROJECTS TO THEIR RELATED ACTIONS
Sorting next actions by context, not by project, can initially seem awkward. Some people are used to having
multiple files, piles, notepads, documents, and spreadsheets related to a project, with next actions for the
project buried amongst all of that information. Next Actions lists don’t replace project plans—we would just call
that data “project support,” and in our experience, it rarely works to have current next actions buried among
project support for day-to-day action management.
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Think of the last time you had 20 minutes free and decided to work on a key project. How easy was it to dig
through your project support to find the immediate next actions based on the tools, people, and places available
to you at the moment? You probably chose to avoid it and do something else, especially if you knew there was
still thinking to do on next actions in the project materials.
When your next actions are already defined and sorted by context, you can move more quickly, more easily,
and more in sync with how you are naturally choosing what to do first—by context. Then project support
remains the parking lot for actions that are incubated for future action.

USING KEYWORD SEARCH
You can always add a keyword for the project in your next action or waiting for description. That way, you can
rely on the powerful Things Quick Find function to pull together related information. For example, if you wanted
to pull together everything related to the “Tahiti” project, searching on that keyword will show you the results
of all entries that include that word. To initiate search, simply start typing the first few letters of your search
keyword in Things, or use the Quick Find icon
at the bottom of each list, or use the keyboard shortcut
Command + F. Enter your keyword and choose to Continue Search to see search results among your Areas,
Projects, and Tags (not Headers.)

USING TAG SEARCH
Tags are also another option for linking projects to their related actions, instead of or in addition to a search
keyword. For example, you could tag the project, and all of the related next action and waiting for items.
Then, when you search on that tag, you can see everything related to the project in one quick view.
To add a tag to an entry, click on the tag icon in any entry.
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Type the first few letters of the tag name to select an existing tag, or type the full keyword if you want to create
a new tag. Press enter/return to save the tag assignment.

To then search on that tag, click on the tag name to see all items with tag within that list.

To search for all items with that tag in all lists, you will need to use Quick Find as we described earlier.

OTHER USES FOR TAGS
Other useful ways to use tags would be to link items to related people, teams, or Areas of Focus2. For example,
if you wanted to see everything related to your Business Development Area of Focus role, because that would
help drive your decisions about what to work on, you could create a tag for that.

Be careful that whatever additional criteria you add for creating new entries, like creating and adding
tags, do not become a burden or requirement. You may find tags useful for one entry, but overkill for
another. It’s easy to let a feature like tags become unwieldy, so watch it carefully to ensure it’s helping
your productivity and not hindering it. Use tags sparingly and judiciously.

2

See the Getting Things Done book or our GTD Methodology Guides in our online store for more coaching on defining your Areas of Focus.
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USING TAGS FOR CONTEXTS
Some of you may be wondering, “Why don’t they recommend using tags for contexts?” While this is a popular
way to set up Things, there are a few reasons why we DON’T lead with this as the suggested setup, including:
yy Tagged items need to be assigned to a list. This would make sense for actions related to projects, but what
about actions that have no related project? How would you track “Buy shampoo”? You would need to create
a “fake” project to assign the action to called something like “No Project,” which you could certainly do,
but that will then make sorting by context (which is your first limiting criteria when choosing what to do)
overwhelming. You would have to wade through dozens and dozens of tagged entries to find actions that
match your current context.
yy It takes extra steps to search on tagged items. GTD is about reducing drag in your workflow. Creating your
lists using the projects form, as we described in the list setup section earlier in the guide, is faster than
searching on tags for seeing related items. If the Things app changes someday and makes tags even faster
to view, we’ll be happy to relook at this!
yy Some people say they want to use tags to be able to park items under multiple contexts, but that doesn’t
happen as often as you may think. It certainly doesn’t happen enough to justify setting up contexts this
way versus the value and simplicity of creating lists for your contexts, as we described earlier in the Guide.
If you do want to see something under multiple contexts, simply highlight the item, use Command + D
to duplicate the To-Do, and move the duplicated item to another list.

THE GTD WEEKLY REVIEW

®

Rest assured, the Weekly Review is what ties the whole thing together, ensuring that you have actions on all the
active parts of your projects on a consistent basis, primarily based on those project support materials, so you
can trust that what you are choosing from your Next Actions list is current. You’ll find the 11-step Weekly Review
checklist in the Getting Things Done book and in our Methodology Guides in our online store.

CUSTOMIZING YOUR CONTEXTS
The lists we have suggested should serve as a starting point. You may need more of these or fewer. For example,
some people find they want to break out Computer into more specific lists, such as personal vs. professional,
or a list just for email-related next actions. Executive support staff can often use a context called Meetings
to Schedule. Some managers find a Projects-Delegated list useful as a high-level Waiting For list and Projects-On
Hold to stage projects that aren’t current, but aren’t Someday/Maybe either. Or, you may find you don’t want to
use as many contexts, and a simple list called Next Actions, or Next Actions-Work and Next Actions-Personal
would suffice for your action lists.
Be willing to experiment to find the set of lists that will work best for you.

MOVING ITEMS BETWEEN LISTS
When you are working your GTD system, you’ll be moving items between lists frequently. For example, you may
have a next action in your Calls list to make a call. If you reach their voicemail but need to track that the person
calls you back, that item would get reassigned to the Waiting For list. Or, you may have a project that has changed
in priority and became a someday/maybe, or vice versa.
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To change the list assigned to an entry, highlight the entry on your list, press Shift + Command + M, and select
the new list, for example, moving an item currently on the Projects list to Someday/Maybe:

Or, simply drag it from one list and drop it in another. For example, to move a next action from the Calls list
to the Waiting For list, drag it from the Calls list to the Waiting For list:

USING FILTERS
Things offers several views, for filtering your list data in different ways:
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Today (Command + 2) – When you create a “start” date on items using the Today icon
, you will see items
that are set to start today in the Today view. This is a tricky feature for us to recommend, given it means items
with a future start date will sit idle on your lists, forcing you to skip over them if their start date isn’t today. We
recommend your lists only hold items you can move on now—not also house “future actions,” which would
instead live in project plans, waiting for, someday/maybe, or on your calendar as a tickler item in the future.
However, where we could see this Today view being useful is if you are making a conscious choice day-to-day
about your highest priority items to work on for that day, assign them to a start date for today, and clear that
list at the end of each day. Where it will deteriorate quickly in value is if you allow items to roll over day to day.
It should be considered a quick “punch list” for must do items that you have carefully chosen to extract from
your other lists. It should in no way be considered a replacement for reviewing all of your lists regularly, as your
priorities shift.

If you are going to use this feature, you may want to enable the Things widget in Mac Notification Center, to see
a snapshot of your Today view.
1. In the menu bar at the top of your Mac’s screen, click the Notification Center icon.
2. In the toolbar at the bottom of Notification Center, click Edit.
3. Find Things in the list of available apps.
4. Click the + button to add it to your Today tab.

Again, to stay conscious with this list and ensure it’s an accurate list for each new day, at the end of the day,
go to the Today view, highlight all of the items (Command + A), then use Command + R to clear the Today
assignment.
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Upcoming (Command + 3) – The Upcoming view shows you all items that have an upcoming start date
or deadline/due date.

Anytime (Command + 4) – The Anytime list is a consolidated view of items that have no start date
on all of your lists.

To change how many items appear in your Anytime list, go to View > Next Action Steps, and change to your
desired number (1–9).
Someday (Command + 5) – The Someday view shows items that you have assigned a start date of Someday.
While in concept this seems aligned with GTD, we recommend using a designated Someday/Maybe list instead.
Assigning Someday to an item would be duplicative to your Someday/Maybe list.
Logbook (Command + 6) – Logbook stores items you’ve marked complete. If you ever mark an item complete
by mistake, this is where you can uncheck the completed box to send it back to a list. You can also see
completed items within each list by clicking on Show logged items at the bottom of the list.
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MARKING ITEMS COMPLETE
Many GTD users ask if they should keep or delete completed items from their lists. If you think you’ll ever want
to retrieve the item, we recommend keeping it. Completed items automatically go to Logbook in Things. This can
be useful for year-end reviews when you want to see and acknowledge all of the projects you completed.
You may find this unnecessary though, for all of the next actions. Trust that you know best about what would
be useful for you to keep. As David Allen says, “When in doubt, keep it. When in doubt, throw it out!” The bottom
line is that either works if you are making a choice that works for you.

USING DUE DATES
We recommend using due dates (what Things calls Deadline) judiciously. A quick way to erode trust in your
system is to create a pattern of false due dates, where you are continually questioning what’s a “real” versus
“made up” due date, as well as spending your valuable time changing dates on overdue To-Do items you
thought you would get to. If you do want to add a due date, Things makes it easy with a date picker window:

You can also type natural language
in the deadline box, such as:
tom = tomorrow’s date
2pm fri = 2pm on Friday
next we = 7 days from the current date
in 2 mo = 2 months from the current date
third thur in jul = 3rd Thursday in July

USING REMINDERS
In our coaching experience, many people overuse Reminders and start
to go numb to them. If you use this feature, use them sparingly when you
really need the extra support of being reminded that something is due.
Then start to build your habit of regular reviews of your lists and calendar
to trust you know what’s coming due. Reminders are set under the When window.
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REPEATING TO-DOS
Things offers an interesting feature for creating repeating To-Dos. We often caution people around using this
kind of feature in most apps, because the items stay visible whether you have completed them or not. And,
your calendar is ideal for this kind of repeating item. But Things handles repeating items about as well as any
app can, from a GTD perspective, by allowing you to hide them item until the next interval you want the item
to appear. For example, let’s say you want to check comments on your blog weekly. Here’s how you could set
that up as a repeating To-Do:
1. Click File > New Repeating To-Do.
2. Set the desired repeating pattern, such as weekly.
3. A new item is created on the list you are viewing.

Unfortunately, Things does add the Today assignment (the yellow star). You can remove that Today assignment
by clicking on the item and unselecting Today under the When menu.
The second item it has added has a Waiting tag next to it. This is the To-Do queued up at the repeating interval
you chose. We recommend hiding that from your list by clicking on Hide later items.

CREATING AREAS
Another useful feature of Things is creating “Areas” to group lists of a similar nature or topic. By no means
is this required for your GTD setup. What you’ve set up so far will give you a solid GTD foundation to work from
in Things. Like tags, we’ve seen many Things users overcomplicate their system by creating too many Areas.
Only add Areas if you think they will improve your efficiency and productivity.
Some ideas for Areas:
yy Separating the four types of action lists: Projects, Next Actions, Waiting For, Someday/Maybe
yy Creating a delineation between Professional and Personal lists
yy Grouping reference lists (described later in the Guide)
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Examples:

To create an Area, click on + New List in the bottom left corner of Things and choose New Area, or go to File >
New Area.

USING THE THINGS INBOX
You can use the Things Inbox to hold Mind Sweep items that still need to be processed. For example, you may
have a thought or idea on the fly while you are in email, not know exactly what the next action is yet, but you
don’t want to lose the idea. Adding it to the Inbox stores the idea until you are ready to clarify it (through the
questions on the GTD Workflow Map shown on page 3 of this Guide), to decide what it means and what you
want to do about it. Inbox comes already built into Things as a default list:
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The difference with the Inbox versus your other lists is that these items are unprocessed. You have not clarified
yet what the item is or what you want to do about it. To make the Inbox work, you’ll need to treat items you
create there with the same rigor you would your email and paper Inboxes, meaning, process the items in this
list down to zero on a regular basis.

THERE ARE A FEW WAYS TO CAPTURE INBOX ITEMS
1. Email Items to Inbox
Your Things account comes with a unique email address for emailing items directly to the Inbox. To enable this
feature and find your unique address, go to Things Preferences and turn on Things Cloud. You’ll need to create
a free Things Cloud account, if you don’t already have one. Once created, go back to Things Preferences and
check off Enable “Mail to Things.” Copy the address shown on that window and create it as a new contact
in your email address book, such as “Things Inbox.”

When you send emails to your Things address, the text (up to 2,000 characters and no file attachments) will
be sent to your inbox. It is not possible to send items directly to others lists or add tags using Mail to Things,
but it will be a fast way to send Mind Sweep items to the Inbox.

2. Use Quick Entry or go to the Inbox List to Add New Items
If you are in the Things app, you can add Inbox items by using Quick Entry (Control + Alt + Spacebar),
or by going to the Inbox list directly and adding the item using the + sign, or Spacebar, or Command + N.
By default, all Quick Entry items will go to the Inbox list, unless you’ve changed that in Preferences or change
it manually in the Quick Entry window. For example, here is a Mind Sweep item added through Quick Entry:
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3. Send Items to the Inbox from Other Apps Using Quick Entry
If you are in another app, such as Mail or Safari, you can add also Inbox items using Quick Entry. Your Quick
Entry item note will contain a link as well as any text you’ve selected.
For example, if you’re on a web page for the GTD Methodology Guides and want to capture what you’re seeing
in your Inbox to process later, use the keyboard shortcut Control + Alt + Spacebar. The title of the webpage
and link to the page will be automatically inserted into a new Quick Entry window.

In email, using Quick Entry when viewing an email will copy the subject of the email and create a link back
to the message.

We’ll talk more about using Quick Entry with your email in the Email section later in the Guide.
To enable this feature, be sure to check off Quick Entry with Autofill in Things Preferences AND install Things
Helper when prompted.

REVIEWING YOUR LISTS
On a daily basis, we recommend reviewing your Next Actions lists (the ones we set up as contexts, such as Calls,
Computer, etc.), when appropriate. On a weekly basis, in your Weekly Review, we recommend reviewing
your calendar and all of your actionable lists in Things, including Projects, Next Actions, Waiting For, and
Someday/Maybe lists. This will be valuable time spent to acknowledge what you’ve completed, capture any
new next actions, and ensure each project is moving forward.
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SHARING FROM THINGS
Things isn’t just for managing your workflow; you can also use it for sharing your list data with friends, family,
and coworkers. You can share lists and items on lists. While the sharing feature in Things is not a true
collaboration tool (it’s really more for viewing), and is very basic in functionality, there are some practical uses:
yy Sending your boss your current Projects list,
yy Sending a colleague a project on your list, with related project notes,
yy Sending your errands list to your partner/spouse/roommate,
yy Sending your admin a snapshot of your Today view.
To share an entire list:
1. Go to the list.
2. Click the ellipses next to the list name.
3. Click Share.

4. Select a method for sharing, such as via email.
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For example, if you are sending your projects list by Email, the body of the email will include text only of your
Projects list, as well as any related due dates. It will not include any project notes or tags.

To share an item on a list:
1. Double click to expand the item on your list.
2. Click on the ellipses at the bottom of the page to see sharing options, just like the example below.

The email sharing the Tahiti project with related notes would look like this:

The difference between sharing a list versus sharing an item is that sharing an item will also include related Notes.
To share a view, such as Today:
1. Go to the Today view.
2. Use Command + A to copy all items.
3. Select Items > Share and choose how you’d like to share.
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EMAIL
INTEGRATING ACTIONABLE EMAIL WITH THINGS
Managing email is the most difficult habit for many to change. The master key is working from a regularly
empty inbox.
It takes less mental effort to operate from a zero base than to leave anything sitting in the inbox. That doesn’t
mean that the inbox in email is kept at zero—just that it gets there on some regular basis. The problem is that
most people do not have a system for managing their emails beyond the inbox area, so if they can’t move
on or finish dealing with the email right then, they will leave it in “In” as the safest place.

GETTING YOUR INBOX TO ZERO
Getting your inbox to zero means you have decided about what each email means and what you want to do
about it. Using the questions from the GTD Workflow Map (pictured earlier in this Guide) you would simply ask:

WHAT IS IT?
IS IT ACTIONABLE?
NO Is it trash, to file as reference, or to incubate (add to your Someday/Maybe list, calendar,
Tickler/Bring Forward file3)?
YES What’s the next action?
Do now, delegate to someone else, or defer to do myself later?
Do it now

If it takes less than 2 minutes, handle it in the moment.

		
Delegate it If you need to track this getting completed, track the waiting for reminder in your
		
@Waiting For folder in email or on your Waiting For list in Things.
		
Defer it
			

If needing to do it later, track the action reminder in @Action folder in email, Calendar,
or on a Next Actions list.

If multiple actions, what’s your desired outcome? Track that outcome on your Projects list in Things.

We recommend getting your inboxes to zero daily, or at least once a week in your Weekly Review.

3

For more information on using a Tickler/Bring Forward file, see the Getting Things Done book.
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TWO OPTIONS FOR MANAGING ACTIONABLE EMAIL
OPTION ONE: USE THE EMAIL AS THE REMINDER
Create @Action and @Waiting For folders in your email program and use them as an action list. You would
not also put those reminders on your calendar, or Next Actions or Waiting for lists in Things—the email itself
would be the only reminder. That means you need to scan these folders with as much discipline as you would
your lists and calendar, for reminders of your commitments. The @ symbol is a trick to push these folders
to the top of your email structure for easy access. If the @ symbol does not work in your email program,
try another symbol.

People often like this option for the quick win it gives in getting your inbox processed to zero. The downside with
this option in email is that you have no place to capture the next action or due date that’s associated with that
actionable email. So, you’ll inevitably be doing some “re-deciding” about emails you’ve already processed if the
next action is not apparent in the subject line.

OPTION TWO: USE YOUR LISTS IN THINGS OR YOUR CALENDAR AS THE REMINDER
Create @Action Support and @Waiting For Support folders in your email program to hold emails that support
actions that are tracked on your calendar, Next Actions, or Waiting For lists. In this case, the folders only serve
as storage buckets to hold the information you need to take the action on. You would be reminded of the action
when you review your calendar, Next Actions, or Waiting For lists. It’s one less place to look for actions or waiting
for items, whereas the first option adds an additional location to look for a complete view of your reminders.

People often like this second option because all of your reminders will be tracked in as few places as possible.

If you using option two, there are two ways to link actionable emails to your lists in Things:
1. Forward the email to your Things Inbox
Using your unique Things email address as described earlier in the Guide, forward the email to your Things Inbox.
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It will appear as a new item in your Inbox with a link back to the email in your email program and up to 2,000
characters of text from the email. It’s very important to edit the subject line (highlighted in blue below) to reflect
your next action or waiting for. Then collapse the item and drag and drop to the correct list (such as Computer.)

When you are ready to take action, simply click on the linked message in your Things To-Do to open the email
directly in your email program.
2. Use Quick Entry with Autofill
The second way to link emails to your lists in Things is to use Quick Entry with Autofill. When viewing an email,
and with Things running in the background, use the keyboard shortcut Control + Option + Spacebar. If you
haven’t highlighted any text, a new Quick Entry window opens with simply a link to the email and the subject
line the same as the email:

If you highlighted any text in the email before pressing Control + Alt + Spacebar, that text will also be included
in the Quick Entry window:

Edit the subject line to reflect your next action or waiting for and change the list assignment from Inbox.
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CALENDAR
WHAT BELONGS ON YOUR CALENDAR
Outside of Things, your calendar is a critical component in your system for reflecting the action choices that
need to be done ON a specific day versus those that you see on your Next Actions lists in Things, which can
be done BY a specific day, or on ANY day. Your daily calendar page should represent the “hard landscape”
for your day and will provide a trusted foundation at a glance for moment-to-moment orientation about what’s next.

THERE ARE ONLY THREE THINGS THAT BELONG ON YOUR CALENDAR:
1. Time-specific actions Things that need to happen on a specific day and time.
Examples:
yy Meetings, appointments, time blocked to work on projects

2. Day-specific actions Things that need to happen during the day, but not at a specific time.
Examples:
yy A call you have to make before you leave for the day
yy Something that you have to finish and submit by the end of the day
yy An agenda you must cover with someone before they leave the office

3. Day-specific information This is information you want to know or be reminded of that day—not necessarily
something to do.
Examples:
yy Events that might disrupt your day (server shut-downs, office moves, etc.).
yy External events to be aware of (marathons, elections, heads of state visits, etc.).
yy Activities related to other significant people of interest to you (kids, spouses, bosses, assistants,
vacations, etc.).
Here is a calendar showing all three types of entries:
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REVIEWING YOUR CALENDAR
On a daily basis, we recommend reviewing your calendar for time-specific and day-specific actions, any chance
you get. On a weekly basis, in your Weekly Review, we recommend reviewing your Calendar backward for any
“Oh, that reminds me…” items, and forward for any “I need to start preparing for…” items to capture.

SETTING UP A CALENDAR FEED
Things offers a feature for displaying your Apple Calendar events inside of Things in your Today and Upcoming
views. While this view certainly does NOT replace reviewing your calendar daily, you might find it helpful as an
extra safety net for reminding you of items that are due.
To set up the calendar feed, go to Things Preferences > Calendar Events and check off Show Calendar Events…
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REFERENCE
USING THINGS TO STORE REFERENCE INFORMATION
Things can manage a limitless number of potentially useful (and fun!) non-actionable simple reference lists and
checklists that you would not want to combine with your Next Actions lists. This functionality is open-ended
and, in one sense, so simple the possibilities are infinite.
Have you ever…
yy had a wild idea you didn’t know what to do with?
yy wanted to remember the great restaurant you ate at in London?
yy needed to remember all the things to check before you leave on a trip?
yy read something inspirational you wanted to keep and re-read every once in a while?
yy wondered where to put a suggestion about something to do the next time you visit a country?
yy needed to remember everything you need to handle when you put on a special kind of event?
yy wanted to keep track of all the articles, blog posts, or essays you might want to write?
yy wanted to have a list of clients and prospects to review occasionally?
yy wanted a place to keep track of the possible gifts to give special people in your life?
yy needed a place to capture great team building and staff recognition ideas?
yy needed a quick emergency contact list?
Here are some possible new reference lists to try:
yy Checklists (e.g. Weekly Review, Packing, Home Maintenance)
yy Areas of focus
yy Higher Horizons of Focus
yy Fun
yy Ideas
yy Inspirations and affirmations
yy Great quotes
yy Lists
yy Might like to buy
yy Might like to read
yy Music to download
yy Next time in…
yy Travel
yy Vacation ideas
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You have a few options for how to set this up, depending on your preference. As we consistently suggest,
be careful to not overcomplicate your system to the point where it becomes unwieldy to find or maintain
the information.

EXAMPLE ONE: CREATE MULTIPLE REFERENCE LISTS WITHIN ONE REFERENCE AREA
To create an Area, click on + New List in the bottom left corner of Things and choose New Area. Name your
Area Reference.

Then, create individual lists (+ New List > New Project) to nest under that Area.

EXAMPLE TWO: CREATE INDIVIDUAL ITEMS UNDER ONE REFERENCE LIST
With this option, details for each item are parked in the Notes field.
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You could have dozens, if not hundreds of items of various topics in one Reference list. For that reason, you
may want to add Tags, like Travel, House, etc., to these list items to be able to sort quickly. Clicking on a tag
(highlighted in blue below) will show you all of the items within that list assigned to that tag.

EXAMPLE THREE: CREATE REFERENCE AREAS BY TOPIC
If you expect to have quite a bit of Reference, you may want to consider creating separate Areas by topic.
For example, if you have many travel-related reference items, you could create a Travel reference Area just
to store separate travel lists.

You may also find it useful to create a Horizons of Focus Area, with each horizon as its own list.

If Things feels limiting to you for managing reference, you may want to consider keeping your Projects, Next
Actions, Waiting For, and Someday/Maybe lists in Things and the majority of your reference in another tool,
such as Evernote® or OneNote®. We offer GTD Setup Guides in our online store for both of those tools to get
you up and running quickly.
The possibilities with capturing reference are endless. Just remember to keep it clean and current, and fast and fun.
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GTD & THINGS | SETUP GUIDE

CONCLUSION
ADDITIONAL RESOURCES
We hope this instruction guide has been useful. It is intended as a supplement to our core education of workflow
mastery developed over many years—not a substitute. The most successful implementation of this guide builds
on the understanding of the GTD best practices presented in our many learning tools, including the Getting
Things Done book, the courses and individual coaching offered by our global partners, and our online learning
center GTD Connect®.
Please visit our website to take advantage of the many support tools and training available to assist you in getting
your GTD system up and running.

FOR TECHNICAL SUPPORT WITH THINGS, PLEASE VISIT:
culturedcode.com/things

FOR MORE INFORMATION ABOUT GTD, PLEASE VISIT:
gettingthingsdone.com
gtdconnect.com
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